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God's Word for Windows V1.2 is an easy to use Bible reference program that runs under Microsoft 
Windows* Version 3.0 and 3.1. God's Word for Windows V1.2 allows the user to locate verses in the Bible
by topic, phrase**, keyword or direct reference.    Search keywords may be specified using optional wild 
cards and Bible may be searched by area such as Paul's Letters, or the Pentateuch. God's Word For 
Windows V1.2 also has enhanced copy, append and print functions. The user is able to copy, append and
print single verses, an entire chapter or the entire list of verses found in a search. God's Word for 
Windows V1.2 also allows the user to add his or her own topics to the 270 topic topical index. 
The base module of God's Word for Windows V1.2 contains the complete Authorized Version, Matthew 
Henry's Concise Commentary** and Easton's Bible Dictionary**. The Darby**, Young's Literal 
Translation** and Weymouth's New Testament in Modern English** are also available for purchase or by 
download from the God's Word For Windows customer support BBS at 604-474-1664.

* Microsoft and Windows are registered trademarks of Microsoft Corporation.
** New for version 1.2



What's New In Version 1.2:

A number of new features have been added to version 1.2 including:

Matthew Henry's Concise Commentary
A commentary published by Moody Press, 28th printing.

Eastons Bible Dictionary
These Dictionary topics are from M.G. Easton M.A., D.D., Illustrated Bible Dictionary, Third Edition, 
published by Thomas Nelson, 1897. Definitions are only a double click away. To use the dictionary, you 
need only double click the unfamiliar word within the chapter window - A great way to learn about Biblical 
people and places.

Young's Literal Translation (optional)
A translation from the same person who wrote Young's Concordance. This translation provides the most 
accurate English rendering of verb tenses.

The Darby (optional)
Considered by many as one of the most English translations available. It is very similar to the New 
American Standard Bible.

Weymouths New Testament in Modern Speech (optional) 
A 20th century translation of the New testament from the original Greek.

Cross Referencing with different translations and commentaries
If you are looking at a passage and would like to see that same passage in another translation or that 
passage explained in a commentary, simply make the appropriate selection from the Version menu.

Phrase Searching
It is now possible to search for verses containing a given phrase such as Kingdom of God, Time to love.

Enlarged chapter field on higher resolution displays
Version 1.1's    text was rather small on Super-VGA displays. Version 1.2 addresses this problem by 
increasing the chapter view area proportional to the size of the display.    For example, resolutions of 
1024X768 will have the largest viewing area while 640X480 displays will be smaller.

Word search by double shift clicking
It is now possible to search for a word by bringing up a passage, holding down a shift key and
double clicking on a word. - A great time saver for those of us that prefer not to type.



Searching for Verses On a Particular Topic:
God's Word For Windows includes a 270 topic topical index. If you wish, you may also add your own 
topics to it. For more information on adding your own topics, see the Help Topic Adding Topics To The 
Topical Index To search for verses dealing with a topic, perform the following steps:

1. Choose the topic of interest by pulling down the Topic drop-down list box and choosing a topic 
from that list. For more information on Drop-down Lists see the Program Manager's help topic 
entitled Drop-Down List Boxes.

2. Start the search by clicking the OK button. You may now print the matching verses on the printer
or copy matching verses to the clipboard for insertion into your word processor. For more 
information on printing or copying to the clipboard, see the Help Topics Copying Verses To Other
Windows Programsand Printing Verses On The Printer

If a dialog box appears indicating that no verses were found, try pulling down the search menu and setting
the search selection to All Books.    For more information on the search menu, see the Help Topic Limiting 
Searches To A group of BooksExample:

1. Pull down the Topic drop-down list box and choose the topic Predestination
2. Click the OK button 
3. 120 verses will appear in the Verses Found list box, starting with Genesis 21:12 

*Note - Selecting a topic will erase words you have entered in the or by Words fields and set` verses 
found radio button back to the whole Bible.



Searching for verses containing a given phrase:
1. Activate the first Phrase field by clicking on the Phrase field.
2. Type in the phrase to search for.    Wild cards are not permitted
3. Start the search by clicking the OK button. You may now print the matching verses on the printer

or copy matching verses to the clipboard for insertion into your word processor. For more 
information on printing or copying to the clipboard, see the Help Topics Copying Verses To Other
Windows Programs and Printing Verses On The Printer

Example:

1. Activate the    phrase field by clicking in it with the mouse.
2. Type in the word Kingdom of God
3. Click the OK button.
4. Verses will appear in the Verses Found list box, starting with Matthew 6:33.

Note: If a dialog box appears indicating that no verses were found, try some different words. You might 
also try pulling down the search menu and setting the search selection to All Books. For more information 
on the search menu, see the Help Topic Limiting Searches To A group of Books



Searching for verses containing a words or group of words:
1. Activate the first Words field by clicking on the Words field.
2. Type in the first word using upper or lower case letters. Wild cards may be used. For more 

information on wild cards, see the help topic Using Wild Cards to Locate Verses
3. Optional - Combine the first word with the next word using And, Or, or And Not by clicking on 

either the And,    the Or or the And Not option buttons next to the first Words field.    And enables 
searches for verses containing the first word And a second word.    Or enables searches for 
verses containing the first word Or a second word.    And Not enables searches for verses 
containing the first word And Not    a second word.    For more information on option buttons, see 
the Program Manager's help topic entitled Option Buttons.

4. Optional - Activate the second Words field by clicking on it.
5. Optional - Type in the second word.
6. Start the search by clicking the OK button. You may now print the matching verses on the printer

or copy matching verses to the clipboard for insertion into your word processor. For more 
information on printing or copying to the clipboard, see the Help Topics Copying Verses To Other
Windows Programs and Printing Verses On The Printer

7 Optional - Instead of typing in a word, simply hold down the left shift key and double click on a 
word in the current passage.

Example:

1. Activate the first words field by clicking in it with the mouse.
2. Type in the word love
3. Click the first radio button labeled And
4. Activate the second words field by clicking in it with the mouse.
5. Type in the word hate
6. Click the OK button.
7. 17 verses will appear in the Verses Found list box, starting with    2 Chronicles 19:2.

Note: If a dialog box appears indicating that no verses were found, try some different words. You might 
also try pulling down the search menu and setting the search selection to All Books. For more information 
on the search menu, see the Help Topic Limiting Searches To A group of Books



Using Wild Cards to locate a verse or verses:
Using wild cards to locate verses is useful if you do not know how spell a word or a number of variations 
of a word are of interest to you. For instance, if you wanted to all occurrences of Thaddaeus but could not 
remember if it contained one "d" or 2 "d"s you could specify thad* as your word to search for. Another 
example would be if you wanted all occurrences of the words pray, prayer, praying or prayed, you could 
specify pray* as your search word. Another example would be if you wanted to find all the "ites" in the 
Bible such as canaanites, hittites, ... you could specify *ites as your search word.    Special characters that
are used in wild card expressions are as follows:

* An asterisk matches any number of characters. Examples:
thad* would match Thaddaeus and cana* would match Canaan.

? A question mark matches any one character. For example:
pray?? would match prayed and prayer.

[ ] [ ] matches any characters between the square brackets. Examples:
[ch]*ites would match canaanites, hittites.

As you might have guessed, wild card characters may be combined to make powerful search 
expressions.



Looking up verses directly:

Occasionally, you know the verse you want to look up. To find it without performing a keyword or topic 
search, perform the following steps:

1 Pull down the Book drop-down list box    and choose a book from the list. The Book drop-down list
box is the first list box to the right of the Specific Verse label.

2 Pull down the Chp drop-down list box    and choose a book from the list. The Chp drop-down list 
box is the second list box to the right of the Specific Verse label.

3 Pull down the Vse drop-down list box    and choose a book from the list. The Vse drop-down list 
box is the third list box to the right of the Specific Verse label.

4 Complete the verse lookup by clicking the OK button. The selected verse will now be displayed. 
5 You may now print it or copy it to the clipboard for insertion into your word processor. For more 

information on printing or copying to the clipboard, see the Help Topics Copying Verses To Other 
Windows Programs and Printing Verses On The Printer

Example:

1. Pull down the Book drop-down list box and choose John
2. Pull down the Chp drop-down list box and choose 3
3. Pull down the Vse drop-down list box and choose 16
4. Click the OK button.
5. 1 verse will appear in the Verses Found list box, John 3:16.



Looking up words in the Bible Dictionary:
The Bible Dictionary is used to look up words that you are unfamiliar with. To use the dictionary, perform 
the following steps:

1 Highlight a word you wish defined.
2 Pull down the Version menu and select Easton's 1897 Bible Dictionary
3 The definition for that word will be displayed in a separate dialog box
4 Optional - Instead of highlighting the word and using the Version menu, you may simply "double 

click" the word as it appears in the chapter window
5 Optional - If you come across    a word in the dictionary definition that you wish defined, you may

"double click" that word for a new definition
6 Optional - You may copy the definition to the clipboard from the dictionary by highlighting all or 

part of the definition using the mouse and then pressing <Ctrl > + <Ins>

Example:

1. Activate the first words field by clicking in it with the mouse.
2. Type the word tabernacle
3. Click the OK button.
4. 297 verses will appear in the Verses Found list box, starting with Exodus 25:9.
5. "Double Click" the word tabernacle as it appears in Exodus 25:9
6. The dictionary entry for tabernacle will be displayed.
7. Now, double click the word Moses as it appears in the dictionary. The definition for Moses will be

displayed



Using the Commentary

The commentary is useful in understanding passages of scripture. In God's Word For Windows, the 
commentary is used almost like any other translation. You may locate commentary entries by direct 
reference or by topic. To use the commentary, perform the following steps

1. Display the passage of scripture using one of the previous search methods
2. Pull down the Version menu and select Matthew Henry's Concise Commentary.
3. The commentary entry for that passage will be displayed
4. To switch back to the Bible, pull down the Version menu and select Authorized Version.

Example:
1. Pull down the book combo box and select John
2. Pull down the chp combo box and select 3
3. Pull down the vse combo box and select 16
4. Click the OK button.
5. John 3:16 will be displayed.
6. Pull down the Version menu and select Matthew Henry's Concise Commentary.
7. The commentary entry for John chapter 3 will be displayed.
8. Switch back to the Authorized Version by pulling down the Version menu and selecting 

Authorized Version.



Limiting a search to a group of books
Sometimes the number of verses that a word appears in is too large to be of use. For example, if you 
searched for all occurrences of God, you would find that there are 3892 occurrences of God throughout 
the Bible. One way to trim this number down to a more manageable size is to limit the books that are 
searched. Perhaps you are only interested in the occurrences of God in the Paul's Letters. By searching 
only Paul's Letters for God, the number of verses that match would be 495. To limit the number of books 
searched, perform the following steps:

1. Pull down the search menu and choose the area to limit your search to from the menu.
2. Perform your topic or word search as described above.

Example:

1. Pull down the Search menu and choose Pentateuch
2. Activate the first words field by clicking on it with the mouse and type creat*
3. Click the OK button
4. 17 verses will appear in the Verses Found list box starting with Genesis 1:1

Note: If you are unhappy with the predefined selections on the search menu, or if you are only interested 
in a single book, you may choose specific books to search by choosing the specific books menu item from
the search menu.



Refining Searches
After finding a group of verses of interest, perhaps by using a topic search, you might want to limit your 
search to the resulting list of verses. For example, you might want to find the list of verses containing the 
word light that also is on the subject of angels. To accomplish this, perform the following steps.

1. Perform a topic or word search as described above.
2. Click the radio button labeled Verses Found
3. Perform a word search as described above.

Example:

1. Select Angels from the Topic drop-down list box.
2. Click the OK button
3. Click the "Verses Found" radio button
4. Type light into the first field of the Words edit box.
5. Click the OK button.



Browsing through the list of matching verses
Often, you will need to look at a number of verses to find the right one. You can do this by browsing 
through the Verses Found list box. To do this, perform the following steps:

1. After following one of the previous search procedures, the number of matching verses will be 
displayed next to the Verses Found field and the list of matching references will be displayed in 
the box underneath the same field.    If no verses match, No References Found will be displayed.

2. Activate the Verses Found list box by clicking anywhere in the Verses Found box.
3. Choose verses to peruse by highlighting references in this list box .    The corresponding verse 

will be displayed in the Verse box.    For more information on List Boxes, see the Program 
Manager help topic entitled List Boxes.



Copying a verse or verses to other Windows programs
Often you will want to copy verses from God's Word For Windows into your word processor or other 
Windows programs. This saves you time because you will not have to retype them. To copy verses to 
accomplish this, perform the following steps:

1. Perform a search using any of the previous procedures.
2. Pull down the Edit menu and choose Copy.
3. A dialog box will appear asking you what you would like to copy. You may choose the verse that 

is selected, the entire chapter currently displayed or all the verses appearing in the Verses 
Found list box. Make you selection by clicking on one of the radio buttons and then click the OK 
button.

4. Change to your other Windows application, pull down it's Edit menu and select Paste. The 
verses you selected will be now be inserted.

5. Optional - If you wish to include the special highlight characters in the verses you are copying, 
you may uncheck the Remove { } checkbox.

6. Optional - If you have previously copied some verses to the clipboard, you may want to add to it.
To do this, choose Append instead of Copy from the edit menu and follow the same procedure 
described above. Append is a good way of accumulating a number of verses into clipboard 
before printing them or pasting them into another application.

Example:

1. Pull down the Topics drop-down list box and choose Baptism
2. Click the OK button. 68 verses will appear in the Verses Found list box
3. Pull down the Edit menu and choose Copy
4. Click the Verses Found radio button in the resulting dialog box.
5. Click the OK button in the same dialog box.
6. Change to your word processor.
7. Pull down it's Edit menu and choose Paste.
8. The 68 verses will now be pasted into your word processor.



Printing a verse or verses on the printer
Often you will want a print out of the verses you have found. To do this, perform the following steps:

1. Perform a search using any of the previous procedures.
2. Pull down the File menu list box and choose Print.
3. A dialog box will appear asking you what you would like to print. You may choose the verse that 

is selected, the entire chapter currently displayed, all the verses appearing in the Verses Found 
list box or verses you have copied to the clipboard.

4. Make your selection by clicking on one of the radio buttons in the same dialog box and then click
the OK button.

5. Optional - If you wish to include the special highlight characters in the verses you are printing, 
you may uncheck the Remove { } checkbox. This may be useful to when remembering which 
words you were searching for.

Example:

1. Activate the first words field by clicking in it with the mouse.
2. Type in the word war
3. Click the first radio button labeled And
4. Activate the second words field by clicking in it with the mouse.
5. Type in the word peace
6. Click the OK button.
7. Pull down the Edit menu and choose Print
8. Click the Chapter radio button in the resulting dialog box.
9. Click the OK button in the same dialog box.
10. Deuteronomy chapter 20 should now be printed on your printer.

Note: God's Word For Windows uses the Default printer selected from the Printer section of the Windows 
Control Panel. If God's Word For Windows fails to print, it may be that you have not set up a default 
printer.



Adding topics to the topical index
Even though there are 270 topics in God's Word For Windows topical index there are times when you 
may wish to add you own topics to the topical index or add verses to topics existing in the topical index. 
Perhaps you are working on a sermon on children in marriage and would like to remember the references
you used. A good way to do that would be to add a topic Children in Marriage and add all your verses to 
that topic.

To add a topic to the topical index, perform the following steps:
1. Pull down the Topics menu and choose Insert Topic. Be sure not to get confused with the Topic 

drop-down list box in the search section.
2. Type in the name of the topic you are adding and then press the OK button.

To delete a topic from the topical index, perform the following steps:
1. Pull down the Topics menu and choose Delete Topic.
2. Type in the name of the topic you are deleting and then press the OK button.
3. A message box will appear asking you if you are sure you want to delete this topic. Click the Yes

button if that is what you want to do.

To rename a topic in the topical index, perform the following steps:
1. Pull down the Topics menu and choose Rename Topic.
2. Choose the topic you wish to rename from the Old Name drop-down list box.
3. Type in the new name of the topic in the New Name field
4. Click the OK button.

To add verses to a topic in the topical index, perform the following steps:
1. Pull down the Topics menu and choose Insert Verse.
2. Pull down the Topic drop-down list box in the resulting dialog box and choose the topic you want

to add the verse to.
3. Specify the verse you want to include with this topic using the drop-down list boxes next to the 

Reference label. These list boxes operate the same way as they did when you were Looking Up 
A Verse Directly.

4. Click the OK button. A Message box will appear indicating that the verse was added to the 
specified topic. You may add as many verses as you would like to this topic.

5. When you are done adding verses, click the Cancel button.
6. The next time you search for this topic, all the verses you specified will be included with the 

resulting verse list.

To delete verses from a topic perform the following steps:
1. Pull down the Topics menu and choose Delete Verse.
2. Pull down the Topic drop-down list box in the resulting dialog box and choose the topic you want

to delete the verse from.
3. Pull down the Verse drop-down list box and choose the verse you want to delete.
4. Click the OK button.
5. You may delete as many verses as you would like from this topic. When you are done click the 

Cancel button.

Notes For Network Managers:
1. If God's Word for Windows is installed on a network and the user does not have write privileges 

in the directory where the user topic files are installed, the items on topics menu will appear 
grayed out.

2. If the network manager would like to provide additional topics for his or her users but would not 
like to allow the user to update them, he or she can add the topics from an account with write 
privileges and assign read only privileges to the users. The users will now be able to search for 
those topics but will not be able to modify them.

3. If the Network manager would like to install God's Word for Windows on a network and allow 
each individual user his or her own personal topic file, the manager should set the GW4WIN 



environment variable in each users AUTOEXEC.BAT file to point to a directory on the users hard
disk drive. God's Word For Windows will then use the topics files in that directory.

Example:

1. Edit the user's AUTOEXEC.BAT files using the DOS editor
2. Add the line SET GW4WIN=C:\MYTOPICS
3. Restart the computer.




